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Abstract. Precision agriculture (PA) has been adopted in many countries and crop and country 
specific technologies have been implemented for different crops and agricultural practices. Although 
PA technologies have been developed mainly in countries such as USA, Europe, Australia, where 
field sizes are large, need of PA technologies has been also drawn in countries such as Japan and 
Korea, where field sizes are relatively small (about 1 ha). Although principles are similar, design 
concept and practical implementation of PA technologies shows variations by country due to 
agricultural conditions such as field and crop characteristics. Information on crop yield and quality is 
one of the most important data for successful implementation and evaluation of the PA systems. For 
this purpose, yield monitoring systems have been developed for different crops and harvesters. Yield 
monitoring system usually consists of components for real-time sensing and monitoring of the 
harvesting parameters in the harvester, and components to process the collected data and create 
yield maps in the office. Recently, a 55-kW full feed type combine harvester was developed to meet 
Korean field and cropping conditions. The target crops were soybean, rapeseed, barley, and wheat, 
normal operating speed was 1.7 m/s, and harvesting width was 2 m. In this paper, a post-processing 
software was developed to handle data for the 55-kW multi-crop combine harvester. The yield 
monitoring system consisted of an ultrasonic array grain flow sensor, a capacitance type grain water 
content sensor, an ultrasonic cutting width sensor, and a GPS receiver. Data from the yield 
monitoring system contained errors due to 1) unstable sensor performance (e.g., GPS signal loss), 2) 
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changes in grain flow and traveling speed (e.g., sudden change), 3) transportation delay between the 
cutting and sensing locations, 4) and start and stop delay. First, available post-processing programs 
were surveyed, and the main functions were analyzed. Then, menu systems were designed and 
coded. Finally, the performance was demonstrated using the available data collected in Korean 
fields. The post-processing software will be improved through further tests and evaluation. 
 
Keywords. Precision agriculture, Combine harvester, Yield monitoring system, Yield map, Post 
processing software 
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Introduction 
Yield monitoring system is a critical component in the modern precision agriculture. It is estimated 
that 48 million of the 160 million corn and soybean acres in the U.S. were harvested using combines 
with yield monitoring systems in 2010, to provide the information for crop yield. Yield map is a geo-
referenced graphical representation of the yield monitoring data from a combine harvester (i.e., crop 
yield, location). It would provide not only local information on nutrient absorption, variability of soil, 
and effects of special treatment strategies (Reitz and Kutzbach, 1996), but also play a role for 
agricultural input recommendation and farming profitability. 

On-the-go data collection of crop yield and location simultaneously with sensors mounted on a 
combine harvester and yield map creation were done firstly by Bae et al. (1987). After that, yield 
monitoring systems have been improved, and the accuracy of commercial systems is reported to be 
about 93~99%, depending a type of the system, company, calibration method, and grain feed rate 
(Birrell et al., 1996; Arsland and Colvin, 2002). 

Creating yield map looks easy conceptually, but obtaining accurate and reliable yield map is 
challenging due to following factors (Pierce et al., 1997; Blackmore and Marshall, 1996; Missotten et 
al., 1995):  

 
• Transportation delay between the cutting and sensing locations (from a cutting header to grain 

flow and moisture sensors) 
• Start and stop delay (when a harvester starts and finishes a swath) 
• Changes in grain flow and traveling speed (condition of operating) 
• Unstable sensor performance (a GPS receiver, a grain flow sensor, and a moisture sensor) 

 

In order to solve the above problems in yield mapping, hardware and software, post-harvest data 
filtering and correction have been commonly used. In the aspect of hardware, it is possible to 
improve accuracy by considering the attachment location of the sensor and high-performance 
sensor. Reitz and Kutzbach (1996) reported that the accuracy of a yield map could be improved by 
an additional adoption of a real time moisture sensor, actual swath width measurement, modeling of 
crop redistribution in a combine harvester. Nolan et al. (1996) indicated that the coefficient of 
variation in yield data was reduced from 32% to 10% by the correction of errors from GPS 
wandering, overlapped operation area, and transportation delay. Actual measurement of swath width 
(Sudduth et al., 1998) and correction of overlapped operation area (Han et al., 1997; Drummond et 
al., 1998) were done to obtain better yield estimation by location. Filtering technique is used to 
remove undesired data such as unrealistic yield and location, sudden surge of yield or moisture, data 
in turning and multi-traveled area, data during transportation and stop and start delay (Beck et al., 
1999), which is very important and covers considerable portion of entire data set in small sized plots 
(Chung et al., 1999, 2002; Lee et al., 2012). 

In case of the software, Sudduth and Drummond (2007) and Lyle et al. (2013) suggested automated 
post-harvest filtering and correction of the yield monitoring data. Moreover, various filtering 
techniques for post-processing have already been proposed. The errors could be detected if 
assigned measured values such as GPS data (location) or values unrealistic sensor data, or if the 
measurements are too much different from their neighboring values. Such outlying observations are 
usually removed before further processing (Shearer et al., 1997; Beck et al., 1999; Thylen et al., 
2001; Lee et al., 2005) or replaced by an estimated values based on neighboring yield data points 
(Noack et al., 2003; Bachmaier and Auernhammer, 2004, 2005). Overall, detailed evaluation and 
analysis of yield data and maps has been conducted for more accurate map creation (Blackmore and 
Marshall, 1996; Pierce et al., 1997; Blackmore and Moore, 1999; Arslan and Colvin 2002; Lyle et al, 
2013). 

Although principles and basic components of yield monitoring systems similar, detail specifications 
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are different for different crop, field, and harvester and the operating conditions. In case of the 
Australia, USA, and European countries, combine harvesters are relatively large, indicating greater 
swath widths and grain flow rates, than those in Korean and Japan, where field sizes are usually 
about 1 ha (Brett and James, 2013). Recently, a 55-kW full feed type combine harvester was 
developed to harvest soybean, rapeseed, barley, and wheat. Normal driving speed of combine 
harvester was 1.7 m/s, and cutting width was 2 m. The yield monitoring system consisted of an 
ultrasonic-array grain flow sensor, a capacitance type grain water content sensor, an ultrasonic 
cutting width sensor, and a GPS receiver (Choi et al., 2015). 

In this study, a post processing software for grain yield monitoring systems suitable to Korean full-
feed combines was developed, and the performance was demonstrated using the available data 
collected in Korean fields. 

 

 
Fig 1. Diagram showing yield monitoring system components on a combine harvester and a post-processing software. 

Materials and Methods 
First, available and commercial post-processing software for yield monitoring systems was surveyed. 
Then, menu structure was designed to meet Korean harvesters and users, and the software was 
coded. Finally, the performance was demonstrated using the available data collected in Korean fields 
and USA fields. 

Survey of post-processing software 
Surveyed and selected post-processing software included SMS (Ag Leader Technology, Iowa, USA), 
Manager (Back Paddock Company, Queensland, Australia), PDP (Fairport Software, WA, Australia), 
PFS (New Holland Agriculture, Greater London, UK), Vesper (Australian Centre for Precision 
Agriculture, NSW, Australia), and Yield Editor (USDA ARS, MO, USA). They had different target 
users. For example, those developed by commercial companies focused on the management for 
field, fund, and soil, therefore had various functions for user comfort. The followings are examples of 
functions for comfort 
 
• Background, Import form, Interpolation, Statistics, Management, Others 

 

Background function divided the display sections, and provided field maps using the Google Earth. 
Moreover, each company had its own data format to provide various functions for farmers. The 
commercial software provided a function to load data in different formats. Kriging and nearest 
neighbor interpolation algorithms were implemented to create more precise yield maps. Statistics 
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function calculated minimum, maximum, mean, median, standard deviation, and variance of the yield 
data. Management function helped farmers manage their asset more conveniently, predicting price of 
the crop. For farmers’ comfort, 3D yield maps, soil maps, and EC maps could be displayed. 

Filtering and correction 

Vesper and Yield Editor focused on the data filtering and correction. The major functions are as 
followings. 

 
• Vesper: [Files] - [Kriging] - [Variogram] 

 

[Files]: The menu is used to load the yield data. Users confirm the spatial coordinates and yield data 
format. 

[Kriging]: Kriging parameters such as grid size, shape, distance, and boundary are specified. 
Punctual and Block kriging options can be selected. 

 

   

  
Fig 2. Interface of the “File” tab (upper left), “Kriging” tab (upper right), and result of the Kriging interpolation (bottom). 

[Variogram]: First step of this menu is to select “Local variogram” or “Global variogra”. “Global 
variogra” uses all the entire data in the field to produce a variogram. “Local variogram” calculation is 
designed for high density data, and calculate at every interpolation grid point using a predefined 
number of neighborhood points. The local variograms capture the amount of variation around each 
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grid point and use this information in the interpolation process. The global variogram is then used to 
calculate the interpolated values at all points on the field grid. The next step is to select variogram 
models among spherical, Gaussian, exponential, linear with sill models, and control the number of 
lags, lag tolerance, maximum lag distance to apply the most suitable delay time. 

 

   

 
Fig 3. Interface of the “Variogram” tab (upper left), set-up the variogram (upper right), and result of the variogram (bottom). 

 

 
Fig 4. Summarized functions of “Vesper” software. 
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• Yield Editor: [Load/Import File] - [Filtering, Mapping and Editing] - [Save/Export File] 

 

[Load/Import File]: Load or import files, and provides average grain flow rage and water content 
values. 

[Filtering, Mapping and Editing]: Provides various filtering and correction menus: no automated 
filtering, interactive auto/manual filtering, and automatic filtering only. As shown in table 1., minimum 
and maximum yields, minimum and maximum max velocity levels, position data, and delay time 
(overlap) items could be automatically filtered (Chung et al., 1999, 2002; Lee et al., 2012; Sudduth et 
al., 2007 and 2012). Provides fifteen different filtering and correction icons: flow delay, moisture delay, 
start pass delay, end pass delay, maximum velocity, minimum velocity, smooth velocity, minimum 
swath, maximum yield, minimum yield, standard deviation filter, header down req., position filter, and 
adjust for moisture (Sudduth et al., 2007 and 2012). Operator can check the yield statistics such as 
mean, standard deviation, coefficient of variation, number of observations, and range of yield value. 
For maps, zoom-in and zoom-out, data transfer and removal could be operated. 

 
Table 1. Parameter values for automated yield cleaning (Sudduth et al., 2007 and 2012). 

Filter Parameter Value Units 
Position GLlim 0.005  

GUlim 0.995  

MaxY, MinY 
Gbuffer 40 m 
YLlim 0.100  
YUlim 0.990  
Yscale 0.25  

MINYabs 1 bu/a 

MaxV, MinV 
VLlim 0.080  
VUlim 0.990  
Vscale 0.18  

MINVabs 0.5 mph 

Overlap 
Csize 0.3 m 

MAXratio 0.5 headers 

 

 
Fig 5. Interface of the “Load/Import File” tab in the Yield Editor software.  
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Fig 6. Interface of the “Filtering, Mapping and Editing” in the Yield Editor software. 

[Save/Export File]: User can save or export the selected portion of the data (e.g., cleaned, selected, 
or all) in a text format. 

 

 

Fig 7. Interface of the “Save/Export File” in the Yield Editor software. 
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Fig 8. Summarized functions of the Yield Editor software. 

 

Data used  
Data were collected in Republic of Korea and USA. Korean field was a 100 m by 30 m rectangular 
rice paddy field (latitude: 37.2843033; longitude: 126.9564617). Rice, a major crop in Korea, is 
usually transplanted in late May and harvested in late October. A paddy field is generally flooded 
from transplanting until the first fertilization and herbicide application time.  

Rice yield data (ton/ha) were collected on October 19, 1999, with a commercial yield monitoring 
system (Model: Grain Trak; Micro Trak Systems Inc., MN, USA) with an impact-force type mass flow 
sensor and a capacitive type water content sensor, mounted on a conventional Korean 3-row rice 
harvester (R1-301; Daedong; Repubilc of Korea). Corn yield data obtained in Missouri, USA (near 
Centralia Missouri), were also analyzed in the study. The data were obtained using the Ag Leader 
Technology yield monitoring system (Chung et al., 2002; Lee et al., 2012). 

 
Table 2. Summary of the Korean and USA yield data used in the study. 

Crop Number of Points Turning Area Yield (kg) STD CV 
Rice 4393 33 3192 0.94 0.92 
Corn 5682 41 4056 0.21 0.30 

 

 
Fig 8. Yield maps created with the Korean rice data (left), and USA corn data (right). 
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Conclusions and discussion 

Menu structure of the post-processing software 
Software was developed based on C# (Model: Microsoft Visual studio; Redmond, WA), and could be 
installed in desktop and laptop computers. The language C# did not require installation Active X files 
for the GUI, and could be run directly in the desktop and laptop computers.  

Functions of the developed post-processing software could be divided three parts; File, Statistics, 
Data. Figure 4 shows interface of the post-processing software. 

Functions  

• Post-processing software: [File] - [Statistics] - [Data] 

[File]: The tab includes functions of data input/filtering/correction, yield map, yield statistics. Clicking 
on the “File”, a new window pops up to load files in *.txt and *.xlsx formats. Using the data filtering 
and correction function, data can be removed or changed in the yield map, and also shows the yield 
statistics (mean, standard deviation, CV, N, range). More options in the filtering and correction 
function are “Flow delay”, “Moisture delay”, “Start pass delay”, “End pass delay”, “Min velocity”, “Max 
velocity”, “Smooth velocity”, “Min yield”, “Max yield”, “STD Filter”, “Header Down Req.”, and “Position 
Filter”. 

 

 
Fig 9. Interface of “File” tab. 

“Flow delay” and “Moisture delay”: time duration from the time of crop cutting and the time of sensor 
measurement. The delay times are affected by various factors such as harvester specifications, 
sensor location, and operation conditions. The function moves the data in backward direction by the 
specified delays 

“Start pass delay” and “End pass delay”: Sensor measurements experience a transient region during 
the start and end pass delay periods. The filtering option removes the data.  

“Min velocity” and “Max velocity”: The filter removes data with unrealistic velocity values. 

“Smooth velocity”: Conduct moving average with a specified number of points. 

“Min yield” and “Max yield”: Remove data with unrealistic yield values. 

“STD Filter”: Remove the yield data out of the specified number of standard deviations from the field 
mean. 

“Position filter”: Remove data manually or automatically. User can specify the coordinates of the field 
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boundary. Automatic position filter corrects data based on the harvester speed. For example, when 
the harvester speed is 1 m/s, the position difference between the adjacent two locations should be 
less than 1 m. 

 
Fig 10. Definition of the measurement and start delay times. 

 
Fig 11. Graphical diagram explaining the “Automatic position filter” using the harvester speed. 

[Statistics]: Number and legend of yield classes can be specified up to 10 classes with equal number 
or equal interval schemes. Provides information on yield minimum, maximum, mean, median, 
standard deviation, variance, and data count. 

 

 
Fig 12. Interface of the “Statistics” tab. 
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[Data]: Data columns or types to be saved are specified. In addition, it is possible to search 
expectation of grain yield price and change the order of data columns.  

 

Fig 13. Interface of the “Data” tab 

Demonstration of the post-processing software functions 
File: [Filtering and correction]-[yield map]-[yield statistics] 

Figure 14 shows two yield maps with 5 (left) and 10 (right) classes. Figure 15 shows the effects of 
different delay times. Left figure showed more “saw tooth” pattern with a 8-s delay time, and right 
figure showed more natural pattern with a 12-s delay time. 

  

Fig 14. Yield map with USA data (left: 5 levels of legend, right: 10 levels of legend). 

 

   

  

Fig 15. Filtered and enlarged yield map by using flow delay (upper left, bottom left: flow delay 8 seconds, upper right, bottom 
right: flow delay 12 seconds). 
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Figure 16 shows results of position filtering. Left figure shows erroneous positions, out of the field 
boundary. Center map was filtered with a 1-m/s speed, and right map was filtered with a 1.6-m/s.  

       
Fig 16. Yield map after the position filtering (left: raw data, center: speed filtered position with a 1 m/s, right: speed filtered 

position with a 1.6 m/s). 

Statistics: [Legend] – [Statistics] – [Graph] 

Figure 17 shows screen display after loading the Korean data. Number of class of 7 with an equal 
interval option. In the left figure, unrealistic maximum value (15.78) was shown, but it was removed 
after filtering, as in the right figure.  

   
Fig 17. Result of the “Statistics” tab (left: Korean data after loading, right: Korean data after filtering data distance in 1.6 m). 

Data: [Select data]-[Data type]-[Expect]-[Order] 

Figure 18 shows result of the “Data” tab, when position, yield, and filtered data were selected. Rice 
price could be also contained referring from the website. 
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Fig 18. Result of the “Data” tab and after selecting the options (left: interface of the “Data”,  

right upper: raw data, right bottom: data after selecting the option). 
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